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MISSION STATEMENT 
 
Booth Library recognizes the desire of users to access information electronically and the 
ever-increasing importance of supplying and preserving content in digital form.  
Therefore, in conjunction with the library’s vision and Eastern Illinois University’s mission, 
Booth Library creates and maintains digital collections to support instruction and 
research and to enrich the campus environment.  Booth Library produces resources 
consisting of historical, educational, intellectual, regional, or cultural significance, and 
seeks collaborative opportunities to make these materials uniquely available in digital 
form.  Booth Library’s digital collections appeal broadly to diverse user groups while 
serving the information needs of the library’s primary audience—the students, faculty, 
administration, alumni, and others within the university community. 
 
 

ABOUT THIS MANUAL 
 

This manual is intended as a working document to guide the development, production, 
and maintenance of digital collections at Booth Library.  As documentation is an 
ongoing process, the committee plans to review and update the manual on an annual 
basis. With regard to this first version, it is anticipated that existing guidelines and 
procedures will be revised and additional policies developed to accommodate the 
institutional repository.  It is also expected that, as project documentation is made more 
complete, the appendix will be converted into separate documents for each 
collection.  
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GUIDELINES FOR DIGITAL PROJECT DEVELOPMENT 
 
This list of criteria, priorities, and other factors is intended to assist Booth Library faculty 
and staff in planning and evaluating proposed digital projects.   
 
All proposed projects must address at least one of the following concerns: preservation, 
access, and/or added value or functionality. 
 

• Significance  
o Identify the historical, educational, intellectual, regional, or cultural value 

of the proposed project 
o Assess the project’s relationship to Booth Library collection strengths and 

digital collections 
• Audience  

o Identify the intended existing or proposed audience, and provide 
evidence of use (e.g., statistics, survey results, planned 
curricular/programmatic use, etc.) 

 Priority will be given to resources that support instruction and 
research at Eastern Illinois University and that have advocates in 
the EIU community for being made available in digital form 

• Uniqueness  
o Determine the uniqueness of the source material and its availability in 

digital form 
 Resources that have already been made publicly available in 

digital form by another agency will not be duplicated; exceptions 
in the case of variation may be decided on a case-by-case basis 

 Priority will be given to materials that are rare or unique to Booth 
Library or Eastern Illinois University 

• Content 
o Define the scope of the project, including but not limited to: topic or 

theme, creator and/or provenance, date range, format 
o Identify and evaluate items to be included in the project 

 Consider whether physical materials can be reproduced in usable 
digital form safely and easily; items in fragile condition or unusual 
formats (e.g., oversize, 3-D, nonprint, etc.) merit special treatment 

o Estimate the size of the project: how many objects, files, pages, etc. will 
be included, as well as the total size of digital files 

• Rights and other restrictions  
o Ascertain whether the resources are in the public domain, or whether 

Booth Library has secured the right to make them available in digital form  
 If not, perform due diligence to obtain permission to digitize and/or 

provide access to copyrighted resources  
 Refer legal questions regarding fair use, privacy, etc. to Booth 

Library Administration for consultation with EIU’s General Counsel 
 Unrestricted public online access is strongly preferred; exceptions 

may be decided on a case-by-case basis 
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• Infrastructure 
o Determine whether Booth Library has the infrastructure to produce and 

support the project, both in terms of equipment (hardware, software, 
server space, etc.) and personnel 

 If not, investigate collaboration with other institutions or outsourcing 
 Priority will be given to collaborative projects (with either campus 

departments or external organizations such as regional, state, or 
national libraries or library associations) 

o Determine whether funding (grants or other financial support) is available 
for the production phase of the project as well as long-term ongoing costs 
such as maintenance, storage, digital preservation 

o Establish a timetable for the project, including a deadline for completion  
• Technical issues 

o Consider the medium (e.g., CD, DVD, streaming, podcast, etc.) and 
format (e.g., JPEG, TIFF, JPEG2000, MPEG-4, etc.) in which resources will be 
made digitally available 

o Investigate the existence of documentation or description providing 
intellectual control of the resource(s) (e.g., cataloging data, inventories or 
finding aids, captions, transcripts, etc.)  

o Determine the hosting site for the final digital product (e.g., CARLI Digital 
Collections, Illinois Digital Archives, Booth Library Web site, EIU Online 
Catalog, etc.), as well as the collection’s appropriateness for inclusion in 
the institutional repository 
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DIGITAL PROJECTS WORKFLOW 
 

Project initiated by Dean or faculty member 

Define collection Project manager 

Set up specifications Library Technology Services  

Digitize (i.e., scan) Students, trained by LTS personnel 

File versioning, storage and backup Library Technology Services 

Cataloging (MARC records in 
WorldCat and EIU Online Catalog) 

Cataloging Services Faculty 

Cataloging (non-MARC metadata) Digital Collections Coordinator 

Files and data uploaded to digital 
collection management software 

Digital Collections Coordinator and/or 
Institutional Repository Librarian 
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LIST OF EQUIPMENT AVAILABLE FOR DIGITAL PROJECTS 
(as of April 2010) 

 
Booth Library 
 
Hardware 

• Scanners 
o Fujitsu fi5750C-HVRS: flatbed 

scanner; located 3000 South office 
area; 12x18; has feeder 

o Fujitsu fi6770: flatbed scanner; 
located in Archives; 11x17; has 
feeder 

• Cameras 
o Canon EOS Rebel XT 
o Nikon D70S 

Software 
• Adobe Suite (Photoshop, etc.) 
• Twain driver 

 
 
Media Services 

 
Production Services provides professional quality studio and onsite digital photography, 
format transfer and conversion, large format printing and audio/video tape and disc 
duplication. Note: Written clearance must be obtained from the owner of copyrighted 
materials before materials can be duplicated. 
Hardware 

• Scanners 
o Nikon 8000 Film Scanner 
o Epson Expression 10000: Flatbed 

scanner 
• Cameras (Bev) 

o Nikon D100 
o Nikon D70S (two) 

• Digital video camera 
o Canon XHA1 

• Microphone equipment 
• Video editing station 

Software 
• Audio editing software 

o SoundForge 

 
 
CATS 
 
Hardware 

• iPod 
Software 
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TECHNICAL GUIDELINES FOR CREATING DIGITAL RESOURCES 
DIGITIZATION OF TEXT AND IMAGES 

 
MEDIA SCAN RAW 

FILE 
MASTER ACCESS THUMBNAIL 

Text 1-bit bitonal 
 
600 ppi 

 

B/W 
image 

8-bit 
grayscale or 
24-bit color 
 
300 ppi 

 

Color 
image 

24-bit color 
 
300 ppi 

 

TIFF JPEG 
Medium to high 
quality 
 
Resize to 1024 
pixels* along long 
dimension 
(*or larger, 
depending on 
standard monitor 
size) 

JPEG or GIF 
 
Resize to 150 
pixels along long 
dimension 

 
These are the default guidelines for all digital text and image resources created by 
Booth Library.  These minimum recommendations may be adapted to meet the needs 
of individual projects on a case-by-case basis; any modifications or additional 
requirements must be noted in the documentation for each project. 
 
(Note: The raw file is the original archival scan or born-digital file, for preservation 
purposes only.  Any minor edits deemed necessary are made to the master file, from 
which access and thumbnail copies are derived.) 
 
For projects hosted by external organizations, consult the guidelines prescribed by the 
hosting site: 

• CARLI, Digitization Best Practices for Images and Text 
http://www.carli.illinois.edu/mem-prod/contentdm/guidelines_for_digitization.pdf 
• CARLI, Digitization Best Practices for Audio 
http://www.carli.illinois.edu/mem-prod/contentdm/guidelines_for_audio.pdf 
• CARLI, Digitization Best Practices for Moving Images 
http://www.carli.illinois.edu/mem-prod/contentdm/guidelines_for_video.pdf 
• Illinois Digital Archives, Guidelines for Images 
http://www.idaillinois.org/guidelines.html  

 
The above guidelines are in compliance with the guidelines established by CARLI Digital 
Collections and the Illinois Digital Archives as of July 2010. 

http://www.carli.illinois.edu/mem-prod/contentdm/guidelines_for_digitization.pdf
http://www.carli.illinois.edu/mem-prod/contentdm/guidelines_for_audio.pdf
http://www.carli.illinois.edu/mem-prod/contentdm/guidelines_for_video.pdf
http://www.idaillinois.org/guidelines.html
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FILE NAMING GUIDELINES 
 

INTRODUCTION 
 
In order to identify and maintain digital resources efficiently, it is recommended that the 
following guidelines be applied when naming files.  More information about the file 
names used for a specific project can be found in the project documentation. 
 
Questions regarding these guidelines should be addressed to the coordinator for digital 
projects: Ellen Corrigan, 581-8456, ekcorrigan@eiu.edu  
 
GUIDELINES 
 

• File names should be unique. 
• File names should be assigned consistently within a given project or collection. 
• File names should contain only alpha-numeric characters, i.e., lowercase letters 

of the Latin alphabet and the numerals 0 through 9. 
• File names should not include spaces or special characters such as, \ / : * ? “ < > 

| [ ] & $ , . except for dashes or underscores as necessary. 
• File names should be as short as possible, with a three-character file extension. 
• If a file name includes numbers, use leading zeros.  
• If a file name uses dates, follow the ISO8601 standard of YYYYMMDD. 
• If a file represents a new version of a document, add a version number to the 

end of the file name. 
• Ideally, the file name will include descriptive information about the item (e.g., 

code indicating project to which item belongs, folder info, item ID from unique 
numbering scheme already used to represent the item, etc.). 

 

mailto:ekcorrigan@eiu.edu
mailto:ekcorrigan@eiu.edu
mailto:ekcorrigan@eiu.edu
mailto:ekcorrigan@eiu.edu
mailto:ekcorrigan@eiu.edu
mailto:ekcorrigan@eiu.edu
mailto:ekcorrigan@eiu.edu
mailto:ekcorrigan@eiu.edu
mailto:ekcorrigan@eiu.edu
mailto:ekcorrigan@eiu.edu
mailto:ekcorrigan@eiu.edu
mailto:ekcorrigan@eiu.edu
mailto:ekcorrigan@eiu.edu
mailto:ekcorrigan@eiu.edu
mailto:ekcorrigan@eiu.edu
mailto:ekcorrigan@eiu.edu
mailto:ekcorrigan@eiu.edu
mailto:ekcorrigan@eiu.edu
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METADATA GUIDELINES 
 

This document outlines the minimum metadata requirements for Booth Library digital collections.  While project-specific 
application profiles may be developed, metadata should be applied as consistently as possible across collections. 
 

As the resource discovery lingua franca for metadata, Dublin Core facilitates interoperability and is recommended as the 
default metadata scheme for two primary reasons: 

1. The Open Archives Initiative Protocol for Metadata Harvesting (OAI-PMH) uses unqualified Dublin Core for 
metadata exchange. 

2. CONTENTdm, the digital collection management system currently available to Booth Library, allows mapping to 
Dublin Core. 

If other metadata schemes are used, application profiles must include a mapping to unqualified Dublin Core elements. 
 

It is further recommended that descriptive metadata content follow current cataloging practice (e.g., AACR2R, RDA) 
and use established controlled vocabularies (e.g., LCSH, LCNAF) when applicable.  Persons responsible for metadata 
creation and input should also consult current best practices for shareable metadata. 
 

Hosting organizations such as CARLI or the Illinois Digital Archives may have additional guidelines, requirements, or best 
practice recommendations.  The required metadata fields, corresponding unqualified Dublin Core elements or other 
mappings, repeatability, controlled vocabulary, and CONTENTdm administrative properties are summarized in the chart 
below.  Refer to the appropriate documents for further detail and examples.  (The most recent versions are cited below.) 
 
Sources consulted: 
 

Dublin Core Metadata Initiative. Dublin Core Metadata Element Set, Version 1.1 
http://dublincore.org/documents/dces/ 
Date issued: 2010-10-11 

CARLI. Guidelines for the Creation of Digital Collections: Best Practices for Descriptive Metadata 
http://www.carli.illinois.edu/comms/board/Metadata_guidelines.pdf 
Created: 4/4/2008 

CARLI. Required Metadata Fields for Collections in CARLI Digital Collections 
http://www.carli.illinois.edu/mem-prod/contentdm/mdatafields09.pdf 
Revised: 12/20/2009 

Illinois State Library, Digital Imaging Program. Illinois Digital Archives: Metadata Guidelines 
http://209.174.179.53/idaDataDictionary.pdf 
Revised: August 2010 

Best Practices for CONTENTdm and other OAI-PMH compliant repositories: creating shareable metadata 
http://contentdmmwg.wikispaces.com/file/view/Best_Practices_2+0.pdf 
Version 2.0 released 10/21/2010 
 

http://dublincore.org/documents/dces/
http://www.carli.illinois.edu/comms/board/Metadata_guidelines.pdf
http://www.carli.illinois.edu/mem-prod/contentdm/mdatafields09.pdf
http://209.174.179.53/idaDataDictionary.pdf
http://contentdmmwg.wikispaces.com/file/view/Best_Practices_2+0.pdf
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Dublin Core element, 
definitions and best practices 

CARLI required fields & 
best practices 

Illinois Digital Archives 
guidelines 

CONTENTdm best 
practices 

Booth Library 

Required Required Core 
 Repeatable Repeatable 

Title 
 
A name given to the 
resource. 

Searchable Searchable  

Required 

Recommended Required if known Core 
 Not repeatable Repeatable: not 

preferred 
 Controlled vocabulary: 

Yes, if applicable 
Controlled vocabulary: 
LCNAF, ULAN 

Creator 
 
An entity primarily responsible 
for making the resource. 

 Searchable  

Recommended  
• when known 

Recommended Required Core 
 Repeatable Repeatable 
 Controlled vocabulary: 

Yes 
Controlled vocabulary: 
LCSH, LCNAF, AAT, TGN 

Subject 
 
The topic of the resource. 

 Searchable  

Required 

Recommended Required Core 
 Repeatable Repeatable 
 Searchable  

Description 
 
An account of the resource. 

 Full Text/Transcript field 
• Map to Description 
• Required for 

documents, audio, 
and video files 

• Searchable 

If full text search, map to 
None 

 

Optional Recommended Core 
  Repeatable 
  Controlled vocabulary: 

LCNAF 

Publisher 
 
An entity responsible for 
making the resource 
available.  Contributing Institution 

field 
• Map to None 
• Required 

 

Required 
• “Booth Library, 

Eastern Illinois 
University” 
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Dublin Core element, 
definitions and best practices 

CARLI required fields & 
best practices 

Illinois Digital Archives 
guidelines 

CONTENTdm best 
practices 

Booth Library 

Optional Recommended; 
Interviewer field 
required for oral histories 

Core 
 

  Repeatable 
  Controlled vocabulary: 

LCNAF, ULAN 

Contributor 
 
An entity responsible for 
making contributions to the 
resource. 

 Searchable  

 

Recommended  Core 
  ISO 8601 W3CDTF 

preferred 
Date Original field 
• Map to 

Date.Created 
• Required 
• Repeatable 
• Searchable 

Date 
 
A point or period of time 
associated with an event in 
the lifecycle of the resource. 
 
Recommended best practice 
is to use an encoding 
scheme, such as the W3CDTF 
profile of ISO 8601 
[http://www.w3.org/TR/ 
NOTE-datetime]  

 

Date Digital field 
• Recommended 
• Hidden 

 

Required 
• Date Original 

when known 
• Use YYYYMMDD 

format (W3CDTF) 
• Include estimated 

dates in 
description or 
under time period, 
not in date field 

Required Required Core 
  Repeatable 
Controlled vocabulary: 
DCMI Type Vocabulary 

Controlled vocabulary: 
DCMI Type Vocabulary 

Controlled vocabulary: 
DCMI 

Searchable Searchable  

Type 
 
The nature or genre of the 
resource. 
 
Recommended best practice 
is to use a controlled 
vocabulary such as the DCMI 
Type Vocabulary 
[http://dublincore.org/ 
documents/dcmi-type-
vocabulary/] 

Not hidden   

Required 
• DCMI 

 
 
 
 

    

http://www.w3.org/TR/%20NOTE-datetime
http://www.w3.org/TR/%20NOTE-datetime
http://dublincore.org/%20documents/dcmi-type-vocabulary/
http://dublincore.org/%20documents/dcmi-type-vocabulary/
http://dublincore.org/%20documents/dcmi-type-vocabulary/
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Dublin Core element, 
definitions and best practices 

CARLI required fields & 
best practices 

Illinois Digital Archives 
guidelines 

CONTENTdm best 
practices 

Booth Library 

Recommended Required Core 
 Map to None  
 Repeatable Repeatable 
 Controlled vocabulary: 

No? 
Controlled vocabulary: 
MIME (preferred), AAT 

Format 
 
The file format, physical 
medium, or dimensions of the 
resource. 
 
Recommended best practice 
is to use a controlled 
vocabulary such as the list of 
Internet Media Types (MIME) 
[http://www.iana.org/ 
assignments/media-types/]  

 Digital Format field 
• Map to 

Format.Medium 
• Recommended 
• Controlled 

vocabulary: Internal 
• Hidden 

 

 

Recommended Required Core 
 Map to None  
 Repeatable Repeatable 

Identifier 
 
An unambiguous reference 
to the resource within a given 
context. 

 Searchable  

 

Optional Recommended 
 

Recommended as 
appropriate 

Source 
 
A related resource from 
which the described resource 
is derived. 

  Repeatable 

 

Required if a text item 
or an item with a 
spoken element 
(audio, video); 
Recommended for 
other types of materials 

Recommended Core 
 

Language 
 
An unambiguous reference 
to the resource within a given 
context. 
 
 
 
 

  Repeatable 

Required  
• when language 

element is present 

http://www.iana.org/%20assignments/media-types/
http://www.iana.org/%20assignments/media-types/
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Dublin Core element, 
definitions and best practices 

CARLI required fields & 
best practices 

Illinois Digital Archives 
guidelines 

CONTENTdm best 
practices 

Booth Library 

Required controlled 
vocabulary: ISO 639-2 

Controlled vocabulary: 
Yes [http://www.sil.org/ 
iso639-3/default.asp], 
input full language 
name 

Controlled vocabulary: 
No, but MARC Code List 
for Languages preferred 
[http://www.loc.gov/ 
marc/languages/] 
 

Language (cont.) 
 
Recommended best practice 
is to use a controlled 
vocabulary such as RFC 4646 
[http://www.ietf.org/rfc/      
rfc4646.txt]  Searchable  

 

Collection field 
required; Optional for 
other information 

 Recommended as 
appropriate 

  Map to Relation.IsPartOf 
  Repeatable 
Searchable   
Not hidden   

Relation 
 
A related resource. 

 Serial Information field 
• Map to Relation 
• Recommended 

 

Required 
• Name of digital 

collection 
• Name of original 

archival collection 
when applicable 

Optional   Coverage 
 
The spatial or temporal topic 
of the resource, the spatial 
applicability of the resource, 
or the jurisdiction under which 
the resource is relevant. 
 
 
 
 
 

 Geographic Coverage 
field 
• Map to 

Coverage.Spatial 
• Required if known or 

applicable 
• Controlled 

vocabulary: No (Yes 
on chart?) 

• Searchable 
 

Location field 
• Map to 

Coverage.Spatial 
• Recommended as 

appropriate 
• Repeatable 
• Controlled 

vocabulary: TGN, 
GNIS, LCNAF 

 

http://www.ietf.org/rfc/%20%20%20%20%20%20rfc4646.txt
http://www.ietf.org/rfc/%20%20%20%20%20%20rfc4646.txt
http://www.sil.org/%20iso639-3/default.asp
http://www.sil.org/%20iso639-3/default.asp
http://www.loc.gov/%20marc/languages/
http://www.loc.gov/%20marc/languages/


 
http://intra.library.eiu.edu/document/digitalcollectionsmanual.pdf      
version 1.0 final 2010-12-13 ekc 
page 15 of 33 
 

Dublin Core element, 
definitions and best practices 

CARLI required fields & 
best practices 

Illinois Digital Archives 
guidelines 

CONTENTdm best 
practices 

Booth Library 

Coverage (cont.) 
 

Time Period field 
• Map to None 
• Recommended 
• Controlled 

vocabulary: Internal 
• Searchable 
• Hidden 

Time Period field 
• Map to 

Coverage.Temporal 
• Recommended as 

appropriate 
• Repeatable 
• Controlled 

vocabulary: AAT 
 Rights Management 

field 
 

 Map to None  
Required Required Core 
 Repeatable Repeatable 

Rights 
 
Information about rights held 
in and over the resource. 

Not hidden   

Required 
• “Use for 

publication only 
with permission” 

• Contact 
information 

• Include citation 
info when 
applicable 

   File Size field 
• Definition: File size in 

KB and duration of 
the digital audio file 

• Map to None 
• Required for 

audio/video files only 
• Hidden 

  

   Browse Topic field 
• Map to None 
• Recommended 
• Controlled 

vocabulary: Internal 
• Searchable 
• Hidden 

  



 
http
v
pag
 

Dublin Core elemen
defini
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t, 
tions and best practices 

CARLI required fields & 
best practices 

Illinois Digital Archives 
guidelines 

CONTENTdm best 
practices 

Booth Library 

   Digitization 
Specifications field 
• Map to None 
• Recommended 
• Hidden 
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METADATA CONVERSION PROCEDURE 
 
Digital resources may have existing metadata that need to be converted from one 
scheme to another.  If metadata conversion is necessary for a particular project, a 
crosswalk mapping the fields between schemes (e.g., MARC to Dublin Core) should be 
included in the project documentation. 
 

These instructions outline the basic process for converting descriptive metadata found 
in MARC bibliographic records in the EIU Online Catalog.  
 

This procedure requires use of MarcEdit (freeware developed by Terry Reese, Oregon 
State University).  You will need to download this software if it is not already installed on 
your workstation.  See http://people.oregonstate.edu/~reeset/marcedit/html/ 
index.php for more information. 
 

1. Request a WRO (Work Request Online) via the local Voyager administrator (John 
Whisler).  He will identify the bibliographic record IDs, place a .txt file containing 
the bib IDs into the Voyager FTP directory, and submit the WRO for MARC Extract 
to CARLI.  The raw data will be delivered to the FTP directory as a .mrc file. 

2. Create a tab delimited text file in Microsoft Excel by saving a blank workbook as 
type Text (Tab delimited).  (Popups may appear when saving and closing tab 
delimited text files in Excel.  To save only the active sheet, click OK.  To keep this 
format, click Yes.) 

3. Open MarcEdit. 
4. From the menu toolbar, select Tools > Export Tab Delimited Records.  A Utilities 

Dialog window will open. 
5. Step 1: Set File Paths.   

• Click the folder icon next to the first box to browse and select the source 
file (.mrc) that contains the input data.   

• Click the folder icon next to the second box to browse and select the 
destination file (.txt) that will contain the output data.   

• From the Select Field Delimiter pulldown menu, select Tab.   
• Click the Next button. 

6. Step 2: Define Fields/Subfields to Export. 
• Check the Normalize field data box (to remove subfield and indicator 

characters in the exported data).  The MARC box should already be 
checked (verifying that the source file is in valid MARC format). 

• Referring to the project crosswalk, enter the MARC fields in the order you 
wish to export them: type in each Field (or select from the pulldown 
menu), type in the Subfield or leave blank to import all subfields in a given 
field, then click Add Field.   

• When you are done, click the Export button.  (An error message will pop 
up if the destination file is in use, so make sure the tab delimited text file is 
not open in Excel before attempting to export.) 

 

At this point, you may reopen the tab delimited text file in Excel and begin editing the 
data.  Each row contains the data from a single bibliographic record, in columns 
corresponding to the MARC fields in the order selected in MarcEdit; the first cell in the 
header row contains all of the MARC labels for the exported data fields. 

http://people.oregonstate.edu/%7Ereeset/marcedit/html/%20index.php
http://people.oregonstate.edu/%7Ereeset/marcedit/html/%20index.php
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PROJECT DOCUMENTATION GUIDELINES 
 
Digital projects should be documented by the project manager(s) as thoroughly as 
possible.  Documentation should be made accessible on the library intranet, be 
reviewed and updated on a regular basis (annually or more frequently for ongoing 
projects), and include the following information: 
 

• Title of project/collection 
• Date(s) of project, including start date, timeline, date of completion, and dates 

of any other significant events in the project lifecycle 
• Name and contact information for project manager(s): The coordinator for 

digital projects should be listed if no project manager is identified 
• Brief description of project: summary of collection content, scope, number of 

items, strengths, notable items 
• Funding source, if applicable, and any accompanying requirements or 

restrictions 
• Technical data: digitization specifications; file naming protocol; file path, 

including name of server/directory/folders in which files are located; number of 
files and total collection size in bytes 

• Metadata application profile 
• Details of Web access: collection homepage URL, name of hosting organization 

if applicable 
• Any additional important information, such as rights, access restrictions, etc.  

 
Questions regarding these guidelines should be addressed to the coordinator for digital 
projects: Ellen Corrigan, 581-8456, ekcorrigan@eiu.edu  

mailto:ekcorrigan@eiu.edu


DOCUMENTATION TEMPLATE 
Ellen K. Corrigan, Chair, Subcommittee on Digital Resources 

4 October 2010 
 
INTRODUCTION 
This template was created on behalf of the Subcommittee on Digital Resources to 
be used as a guide when writing policies and procedures related to Booth Library 
digital resources. 
 
Questions regarding this template should be addressed to the coordinator for 
digital projects: Ellen Corrigan, 581-8456, ekcorrigan@eiu.edu  
 
PROCEDURE 
All digital resources policies and procedures must include the following information 
at the beginning of the document: 

• Title: identifying the content of the document 
• Author: name of individual(s) or committee responsible for writing document 
• Date: original date of final version of document; should include month and 

year 
 
The introductory section of the document must include: 

• Name and contact information for person to whom questions regarding the 
policy or procedure should be addressed.  (This is usually the project 
manager.  If no responsible party can be identified, questions should be 
directed to the coordinator for digital projects, who will handle or refer as 
appropriate.) 

The introduction may also include: 
• Background information: brief statement to explain context of policy or 

procedure, or to include additional relevant information that does not fall 
within policy or procedure itself 

 
Documents should also include the following information in the footer: 

• Path specifying directory\folder\filename location of document 
• Version of document: Note the document status (e.g., draft, final, 

approved, revised), dates of any changes made to the document (day, 
month, year), and name or initials of those responsible for editing document. 

• Page numbering, as appropriate 
 
 
 
 
 
\\boothbeta\units\committee\Digital\Procedures\documentation_template.pdf      
rev. 2010-12-12 ekc            
Page 1 of 1 
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APPENDIX: 
DOCUMENTATION FOR BOOTH LIBRARY DIGITAL PROJECTS 



Title of project: Booth Library Postcard Collection 
Date(s) of project: 2008?-present 
Project manager: Ellen K. Corrigan, 581-8456, ekcorrigan@eiu.edu  
 
Description: The Booth Library Postcard Collection has as its focus the rich history of 
Illinois communities. Of particular note, strengths include: Education in Illinois. The 
collection is especially rich in both interior and exterior views of buildings for schools, 
institutes, colleges, and universities. Additionally, photographs of students and teachers 
are included when available. Libraries in Illinois. This collection was developed in 
conjunction with the Art and Architecture in Illinois Libraries project resident at Booth 
Library. Funded by the LSTA program of the Illinois State Library in 2006 and 2009 and by 
Eastern Illinois University, these postcards illustrate the history of libraries across the state. 
Additionally, library images from other states and nations are included when available. 
 
Technical data:  
\\boothsigma\data2\Postcards 
16,274 files; 314 GB (as of February 
2010) 
 
Web access: All postcards 
accessible at item level via the 
EIU Online Catalog. 
Collection of Illinois postcards 
hosted by CARLI Digital 
Collections,  
http://collections.carli.illinois.edu/
cdm4/index_eiu_postc.php? 
CISOROOT=/eiu_postc 
 
Metadata: See CONTENTdm field 
properties table at right. More 
detailed application profile under 
revision. 
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POSTCARD DIGITIZATION PROCEDURE 
Revised by: Ellen K. Corrigan/Subcommittee on Digital Resources 

13 December 2010 
 
 
INTRODUCTION 
The permanent location for the postcard collection is Special Collections.  However, the 
postcards are being housed temporarily in Cataloging Services (Room 1047), arranged 
in binders by geographic location and call number. 
 
Questions regarding this procedure may be addressed to the coordinator for digital 
projects: Ellen Corrigan, 581-8456, ekcorrigan@eiu.edu.  
 
PROCEDURE 
Log on to scanning workstation in the 3000 South office area. 
username: warbler 
password: lorber64 
 
From Desktop, open Adobe Photoshop.   
 
Take the postcard out of the binder and lay it on the scanner bed, picture side down.  
Slowly and carefully, close the lid to the scanner. 
 
Select File > Import > Fujitsu fi-5750Cdj. 
 
The Twain Driver window will open. 
Select the setting file for Postcards, and verify settings: 

Resolution: 600 x 600 
Scan Type: Flat Bed 
Paper Size: Postcard 
Image Mode: 24bit Color 

Click on the Scan button. 
Close the Twain Driver window. 
 
Use CTRL+ to enlarge or CTRL- to shrink the image to a workable size. 
 
For horizontally-oriented postcards, or to straighten the image, go to Image > Rotate 
Canvas and rotate the image as needed. 
 
To crop out any scanned area beyond the edge of the postcard, click on the “Crop” 
tool  in the toolbox.  Beginning at the upper left corner of the image, hold down the 
left mouse button while you move down and across the postcard toward the bottom 
right corner.  You can adjust the selected area by moving the cropping lines.  Hit the 
“Enter” key.   
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To save, select File > Save.  In the save window, select the location 
\\boothgamma\warbler\postcard.  Use the barcode scanner to scan the barcode 
(located on back of accompanying catalog card in postcard sleeve in binder) into the 
file name box.  (If the postcard does not have a barcode, ask in Cataloging Services.)  
Be sure that the format is TIFF, then click “OK.”  The next popup should have default 
values Image Compression: None and Byte Order: IBM PC; click “OK.” 
 
Repeat the above instructions to scan the address side of the postcard. 
 
When saving the address side of the postcard, after scanning the barcode, choose 
“Cancel” when it asks if you want to replace the existing file.  Then add a letter “b” to 
the end of the scanned barcode number and select “OK.” 
  
Remove postcard from scanner and put back in binder in the proper location. 
 
Close the images and repeat with the next postcard. 
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Title of project: The Little Theatre on the Square in Sullivan 
Date(s) of project: 2008-2009 
Project manager: David Bell 
 
Description: This Booth Library digitization project provides online access to valuable 
information about the history of theatrical performance in downstate Illinois. Through an 
arrangement with Sullivan, Illinois's Little Theatre on the Square, 50-plus years of theater 
programs and some additional ephemera have been digitized. Opened by Guy S. Little 
Jr. in 1957, The Little Theatre remains the only Actors Equity theater between Chicago 
and St. Louis. Over the years, hundreds of shows have been produced and the Little 
Theatre has become an integral part of central Illinois's cultural heritage. Well-known 
actors including Mickey Rooney, Alan Alda, Leonard Nimoy, Robert Reed, Vivian 
Vance, Imogene Coca, Bill Bixby, Bob Crane and many others starred in Sullivan over 
the years. This collaboration reflects Booth Library's commitment to preserving and 
providing access to unique materials that provide insight into the history of the 
surrounding area. The original programs are the property of the Little Theatre on the 
Square; they are currently on loan to Booth Library. 
 
Technical data: 
\\boothsigma\data2\LittleTheatre 
256 files; 2.3 GB (as of February 2010) 
 
Web access: Hosted by CARLI Digital Collections, accessible to the public at 
http://collections.carli.illinois.edu/cdm4/index_eiu_theatre.php?CISOROOT=/eiu_theatre  
 
Metadata: See application profile on next page. 
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THE LITTLE THEATRE ON THE SQUARE IN SULLIVAN 
METADATA APPLICATION PROFILE 

 
Field name Uniform 

Title 
Title of Show Opening 

Date 
Closing 
Date 

Cast Performance 
Venue 

Document 
Genre/Form 

Description 

DC map Title Title-
Alternative 

Coverage-
Temporal  

Coverage-
Temporal  

Subject Subject Subject Description 

Data type Text Text Text Text Text Text Text Text 
Large No No No No No No No No 
Search Yes Yes Yes Yes Yes Yes Yes Yes 
Hide No No No No No No No No 
Obligation Required Rec Rec Rec Opt Rec Rec Opt 
Vocab No Yes No No Yes Yes Yes No 
Application 
guidelines 

Drop initial 
article, add 
year of 
production in 
parentheses 
at end 

Title of show, 
transcribed 
 
 

YYYY-MM-DD  
 
W3C-DTF 

YYYY-MM-DD  
 
W3C-DTF 

Enter top-billed names 
only.  Use form of name 
as established in Library 
of Congress Name 
Authority File when 
applicable.  Otherwise, 
use name as found in 
source.  Format as last 
name, first name.  
Separate names with a 
semi-colon. 

Little Theatre on 
the Square 
(Sullivan, Ill.) 

Theater 
programs 
 
LCSH 

Note cover 
autograph, or 
other irregularities 
or important 
details 

 
Field name Format Type Language Collection Rights Directory Name 
DC map Format Type Language Relation Rights Identifier 
Data type Text Text Text Text Text Text 
Large No No No No No No 
Search Yes Yes Yes Yes No No 
Hide No No No No No No 
Obligation Rec Required Required Required Required Rec 
Vocab No No No No No No 
Application 
guidelines 

image/jpeg 
 
Internet 
Media 
Types/MIME 

Text 
 
DCMI Type 
Vocabulary  

eng 
 
ISO639-2 

The Little Theatre on the 
Square in Sullivan 
(Eastern Illinois University) 
 
80-character limit 

Reproduced with permission. For permission 
to publish, distribute, or otherwise use this 
material, please contact the rights holder: 
The Little Theatre on the Square, 16 E. 
Harrison St., P.O. Box 288, Sullivan, IL 61951. 
Phone: 217-728-2065. 

Name of directory 
containing files to be 
imported 
 
CONTENTdm requires 
Identifier as last field 
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Title of project: EIU Theses 
Date(s) of project: 2008-present 
Project manager: Ellen K. Corrigan, 581-8456, ekcorrigan@eiu.edu  
 
Description: Initiated by Karen Whisler, Head, Collection Management Services, to 
provide access to Family and Consumer Sciences theses to remote program in 
Chicago.  Retroactive digitization of FCS theses began in October 2008.  The project 
has since expanded to include all new theses. 
 
Technical data:  
\\boothsigma\data2\theses 
479 files; 16.6 GB (as of February 2010) 
 
Web access: Accessible at item level via the EIU Online Catalog. 
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THESIS DIGITIZATION PROCEDURE 
Revised by: Ellen K. Corrigan/Subcommittee on Digital Resources 

13 December 2010 
 
 
INTRODUCTION 
Booth Library usually holds two copies of theses: Copy 1 is located in University Archives, 
copy 2 in the circulating stacks on the 2000 South level under call number beginning 
with LB1861.C57x.  The Stacks copy is used for scanning, and its barcode is used as the 
file name. 

• Theses submitted in 2008 and later are scanned upon receipt by the library as 
part of the cataloging workflow prior to binding. 

• Theses submitted in 2007 and earlier are retrieved from the stacks and are 
scanned as bound volumes.   

 
Questions regarding this procedure may be addressed to the coordinator for digital 
projects: Ellen Corrigan, 581-8456, ekcorrigan@eiu.edu.  
 
PROCEDURE 

1. Retrieve theses from shelf using the printed list of titles and call numbers.  
2. Take stack of theses to Cataloging Services (John Whisler, Room 1047) to be 

checked out to “in process.” 
3. Proceed to scanning workstation in the 3000 South office area.  To log on: 

username: warbler 
password: lorber64 

4. Open Adobe Acrobat Pro icon on desktop.   
5. Go to File > Create PDF > From scanner > Black & White Document.  
6. The Twain Driver window will open.  Verify settings: 

Scanner: FUJITSU fi-5750Cdj 
Resolution: 600 x 600 
Scan Type: Flat Bed 
Paper Size: Letter (8.5” x 11) 
Image Mode: Black and White 
 

Note: The above settings apply to bound theses, text-only pages. 
• For unbound theses, you may change the Scan Type to “ADF (Front Side)” 

and place the pages face down in the automatic document feeder. 
• For pages with black and white illustrations (photographs, charts, etc.), 

change the Image Mode setting to “grayscale.” 
• For pages with color illustrations, change the Resolution to “300 x 300” and 

the Image Mode setting to “24 bit color.” 
 

7. Scan the U.S. Copyright Notice as the first page of the document. After 
scanning, a message pops up asking for confirmation to scan the next page.  
Click “next” and the menu from step #6 returns. 
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8. Open the scanner and place the thesis face down, beginning with the “Thesis 
Reproduction Certificate” page, in upper left hand corner, oriented so that the 
top of the page is lined up with the left hand margin of the scanning bed.  Click 
“scan.”  Click “next” and repeat for the rest of the thesis. 

 
Note: For theses with thin pages, to avoid bleed-through of the following pages, 
insert a few blank sheets of paper behind the page being scanned. 
 
Note: Check the sequential order of pages periodically as you scan for 
duplicate, omitted, or out-of-sequence pages.  Scan the document as 
accurately as you can and leave a note with that thesis, describing any 
irregularities or problems you encounter.  

 
9. When all pages have been scanned, click “done.”  To view an outline of the 

scanned pages, click on the “pages” tab at the far left of the screen.   
10. In case of pages scanned upside down, go to the toolbar menu and select 

Document > Rotate Pages.  In the Direction drop-down menu, select “180 
degrees” and click on the radial button marked “all.”  

11. Double-check the pages one by one.  Make sure no pages have been skipped 
and that the scanning quality is good.   

• If errors are found, select “Create PDF” again (Destination: Append to 
current document) and re-scan pages as needed.  The rescanned pages 
will appear at the end of the outline in the “pages” tab.  Use the mouse to 
drag the newly scanned pages in the correct order.  Then highlight the 
old copies to be deleted, right-click the mouse, and select “Delete 
pages”. 

12. To save the completed document, click on File > Save As. From My Computer, 
select the “thesis on ‘boothgamma\warbler’ (X:)” drive, then the “Finished 
Thesis” folder. Scan the barcode in the file name box, then click Save. 

• To save an incomplete document, click on File > Save As. From My 
Computer, select the “thesis on ‘boothgamma\warbler’ (X:)” drive, then 
the “Partially Completed” folder.  In the file name box, type in the author, 
year and page number last scanned.  (Example: For page 21 of the 1983 
thesis by Cobble, you would type Cobble198321.)  Leave a note for the 
next scanner so that he or she can pick up where you left off.   

13. Mark off the scanned thesis from the list in the folder and place the thesis in the 
appropriate pile.   

14. Return scanned theses to Cataloging Services (John Whisler, Room 1047).   
• He will insert the URL for each scanned thesis into the cataloging record, 

discharge the theses from “in process,” and return them to Circulation for 
shelving. 
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Title of project: Eastern Illinois University Yearbook - The Warbler, 1919-1927 
Date(s) of project: ca. 2006 (?) 
Project manager(s): Carl Lorber (retired), Bob Hillman 
 
Description: Published yearly since 1919, and well illustrated, the Warbler conveys 
information on students and faculty, chronicles important cultural and sporting events, 
describes organizational activities, and depicts changes in the campus layout and 
physical plant. This collection includes every page of the first 11 volumes.  
 
Funding: Funding for this grant was awarded by the Illinois State Library (ISL), a Division 
of the Office of Secretary of State, using funds provided by the Institute of Museum and 
Library Services (IMLS), under the federal Library Services and Technology Act (LSTA). 
 
Technical data:  
\\boothgamma\d$\datafiles\Warbler\Docs 
2147 files, 9.2 GB (as of February 2010) 
 
Web access: Accessible to the public via Illinois Digital Archives (State Library), 
http://www.idaillinois.org/cdm4/browse.php?CISOROOT=%2Feiu  

http://www.idaillinois.org/cdm4/browse.php?CISOROOT=%2Feiu
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WARBLER DIGITIZATION PROCEDURE 
under development 
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Title of project: Art and Architecture in Illinois Libraries 
Date(s) of project: 2006- 
Project managers: Allen Lanham and Marlene Slough, principal investigators 
 
Description: Inventory of artists, works of art, and architects represented in Illinois public, 
academic, and research libraries. 
 
Funding: Funding for this grant was awarded by the Illinois State Library, a Division of the 
Office of Secretary of State, using funds by the Institute of Museum and Library Services, 
under the federal Library Services and Technology Act and by Eastern Illinois University, 
Booth Library. 
 
Technical data:  
\\boothsigma\data2\ArtArch 
34,181 items; 512 GB (as of February 2010) 
 
Metadata: 
 
Web access: Collection home page at http://www.library.eiu.edu/artarch/; not yet 
publicly searchable. 
 
 

http://www.library.eiu.edu/artarch/


Title of project: Booth Library Digital Photo Archive 
Date(s) of project: ca. 2000-present 
Project manager: Bob Hillman 
  
Description: 
 
Technical data: 
\\boothgamma\docroot\Mediasrv\image_archive 
10,666 files; 1.25 GB (as of February 2010) 
 
Metadata: 
 
Web access: Accessible to the public via the Booth Library web site, 
http://www.library.eiu.edu/photoarchive/  
 
 
 
Title of project: EIU Photo Collection  
Date(s) of project: 
Project manager: Media Services 
 
Description: Photographs taken by Bev Cruse. 
 
Technical data:  
360 files; 7 MB (as of February 2010) 
 
Metadata: None 
 
Web access: Accessible to the public via the Booth Library web site, 
http://www.library.eiu.edu/mediasrv/image_archive/Image_archive.html 
 
 
 
Title of project: Booth Library Renovation Pictures  
Date(s) of project: 2002? 
Project manager: 
 
Description: Construction pictures, Summer 2000-Winter 2002; opening day pictures, 
February 14, 2002; rededication day pictures, including ceremony, luncheon, reception, 
September 18, 2002. 
 
Technical data: 
\\boothgamma\d$\DataFiles\ImageArchive 
1633 photos; 79 MB (as of February 2010) 
 
Metadata: None; file name used as caption. 
 
Web access: Accessible to the public via the Booth Library web site, 
http://www.library.eiu.edu/about/renovation/images.html  
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Title of project: Classic Works of Art 
Date(s) of project: 
Project manager: 
 
Description: High resolution digital images for 3,139 classic works of art. 
 
Technical data: 
\\boothgamma\d$\DataFiles\ClassicArts 
3271 files; 8.95 GB (as of February 2010) 
 
Metadata: In-house-developed database for supplied data. 
Search title by keyword, or browse indexed list of artist names, museum, period, or 
material. 
 
Web access: Accessible to the public via the Booth Library web site, 
http://www.library.eiu.edu/arts/  
 
 
 
Title of project: DEN 
Date(s) of project: 
Project manager: 
 
Description: 
 
Technical data: 
\\boothgamma\d$\DataFiles\DENPDFs 
29,900 items; 11.7 GB (as of February 2010) 
 
Metadata: 
 
Web access:  
 
 
 
Title of project: Coleman History Project 
Date(s) of project: 
Project manager: 
 
Description: 
 
Technical data: 
\\boothgamma\d$\datafiles\warbler\Coleman 
384 items; 230 MB (as of February 2010) 
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